Quick Start GNS3

GNS3 stand for Graphical Network Simulator 3 and it is a network software emulator that is used to
simulate complex networks. GNS3 runs on Windows, macOS, and Linux, but you must have either
VirtualBox or VMware already installed on your system.

To get started visit: http://www.gns3.com and click the Free Download button.
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» Watch the Video

You must create a free account as shown below.

Sign Up Login

An account is required to download the GNS3 Software and participate in the
Community. To create an account, just fill in the ficlds below!

Login to the GNS53

Community First Name Last Name
E-mail School/Organization
Password Confirm Password
United States ~ Zip Code

| use GNS3 Software for: Education & Training >

[0 sign me up for the GNS3 newsletter

Create Account & Continue

By creating an account, you agree to the GMNS3 Terms and Conditions and Privacy Policy




Once the account is created (or you login) you will be presented with the download page.

DOWNLOAD GNS3

Select the installer for your favourite OS

== & 7o)

Windows Mac Linux

Version 21.6 Version 21.6 Version 2.1.6

B Install Guide for Windows B Install Guide for Mac B Install Guide for Linux
© Download Mirror © Download Mimror

For optimal performance, make sure to also download the GNS3 VM

GMS3 is a Free and Open Source software under GPL v3 licensing

You MUST download the appropriate version for your operating system AND the GNS3 VM that matches
with your virtualization software. Clicking the download the GNS3 VM link presents this page.

DOWNLOAD GNS3 VM
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VIRTUALBOX VMWARE WORKSTATION VMWARE ESXI

© DOWNLOAD © DOWNLOAD

Learn more about the GNS3 VM

S3 is a Free and Open Source software under GPL v3 licensing

Once you have downloaded both the GNS3 software installer for your operating system AND the GNS3
VM which goes with your virtualization software, make note of where you downloaded these files. Then
to start the process, FIRST import the GNS3 VM BEFORE installing the GNS3 software.

The GNS3 VM download file will be in zip file format, so you must copy the contents (i.e., file called
GNS3 VM.ova) out of the zip file and to another location such as Downloads or your Desktop.



To import the GNS3 VM into VirtualBox, choose File from the menu bar and then Import Appliance...
from the File menu. Click on the little folder icon and navigate to the location of the GNS3 VM.ova file
you copied out of the downloaded zip file. Once successfully imported, the GNS3 VM will show within
the list of your virtual machines. Select it and click the Start button to launch the GNS3 VM. Once it
boots up, you should see a screen which shows its IP address. When using VirtualBox, this IP address
should be in the range of 192.168.56.x, likely 192.168.56.101 as this is the range VirtualBox provides via
DHCP to virtual machines on the host-only adapter.

To import the GNS3 VM into VMW are, use the Open a Virtual Machine choose from either the main
screen or the Player/File menu. Use the file open dialog box to navigate to the location of the GNS3
VM.ova file you copied out of the downloaded zip file. Once it is successful imported, the GNS3 VM will
show in your list of virtual machines. Select it and click the Play virtual machine button to launch the
GNS3 VM. Once it boots up, you should see a screen which shows its IP address. When using VMWare,
this IP address is typically in the range of 192.168.157.x under VMnet1, the VMWare host-only adapter.

The example below shows the GNS3 running under VMWare, but the screen looks the same on
VirtualBox except for having a different IP range.

%3 GNS53 VM - VMware Workstation 12 Player (Non-commercial use only) - O X
Payer ~ | Il + & H X «

GN33 2.1.2

GNS3 version: 2.1.2
UM version: 0.10.14
KUM support available: False

IP: 192.168.157.129

To log in using SSH:
ssh gns3e192.168.157.129

Password: gns3

Images and projects are located in ropt-gns3

Release chammel: 2.1

Only once you have the GNS3 VM running successfully within your virtualization environment should
you proceed to actually installing the GNS3 software itself.

The GNS3 software (the GUI front end of the system) installer is generally named in the format of:
GNS3-x.x.x-all-in-one.exe (where x.x.x is the version number) for Windows or

GNS3.x.x.x.dmg (where again x.x.x is the version number) for macOS.



To launch these installers for Windows or macQOS, you simply need to double-click on them to start the
install process.

For Linux, things are a bit different...

The download button for the Linux option actually takes you to another page, where there are
instructions for different versions of Linux including Ubuntu, Debian, Fedora, OpenSuse, and Gentoo
among others. There are also instructions for compiling and installing from the source code. The URL of
this Linux install page is below:

https://docs.gns3.com/1QXVIihk7dsOL7Xr7Bmz4zRzTsJO2wkIfimGuHwTlaA4/

It should also be noted here that links for install guides for each operating system are available from the
download page as well.

Once started the install process for GNS3 is generally fairly easy, but there are a couple of things to
make sure of along the way.

1. Most default choices work fine, though we will point out a couple important choices below.
GNS3 will install a number of things along with its core software including winpcap. When asked
to install additional components generally choose to do so. The exception is the free and trial
stuff offered by Solarwinds, they are completely optional to the functioning of GNS3.

3. One of the first important choices during the Setup Wizard is the choice about server type.

& Setup Wizard ? x
Server
Pleage choose a server type to run your GNS3 network smulatons. The GNS3 VM i strongly recommended on Windows and Mac OS5 X,
® Run modern 105 (I0Sv or TOU), ASA and appliances from non Cisco manufacturers.
This vl require an additional VM (the: GNS3 VM is available for free]
Run onby legacy 105 on my computer
Requires [0S mages <= (7200
Run everything on a remote server (advanced usage)
The server vl be on & remote computer and can be shared with multiple users.

Don't how ths again

For most people, the first and default choice is appropriate.

4. The most critical thing to get right during the installation is the IP address of the Host binding
choice. This MUST be the real IP address of your system’s network interface (whether wired or
wireless). This usually is in the range of 192.168.0.x or 192.168.1.x using most typical home
routers. You can use either ipconfig or ifconfig to check the IP addresses of your interfaces.
Make sure you do not pick 127.0.0.1 or an IP assigned to a virtual network interface.



€ Setup Wizard 2 W

Local server configuration
Plaste configure the following GNSS local server settings

Server path:  C:\Program Fies\GNS \grsserver EXE Bramze...

Hostbinding: | 169.254.179. 250

Port; 3080 TGP -

< Back Hext> || cancel

5. The last major thing to get right, is to correctly select the virtualization environment you are
using. Once you select the right one, it should auto fill in the GNS3 VM name in the drop down.
The example below shows choosing VirtualBox instead of the default VMWare.

& Setup Wizard ? x

GNS3 VM
In order to run the GNS3 VM you must first have VMware or VirtualBox installed and the GNS3 VM.ova imported with one of these software.

Virtuakzation software:

VMware (recommended)

' VirtualBox

vimware

NORKSTATION ’
PRO I SAVE 20%
Leading Edge PC Virtualization _

And import the VM in the virtualization software and hit refresh,

VM name:

GNS3 VM - Refresh
vCPU cores:

1
RAM size:

2048 MB -

< Back | Next> Cancel

Once the install is finished and GNS3 launches, expect to see a small black box (a Command prompt type
box, but it will be blank) pop up briefly before the GNS3 GUI appears. If all goes well the ‘local’ GNS3
server software (i.e., the stuff you just installed on your system) will be able to connect up with the
GNS3 VM and you should see two green lights under the Servers heading on the right side of the GNS3
GUI as shown in the image on the next page.
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From this dialog you can create your first project or open an existing one. Create My First Project by
typing this into the Name field and clicking OK. This creates a blank topology. Click on the second to the
last button on the left side to Browse all devices. This will display a list of Installed and Available devices.
Only a handful of default devices come pre-installed with GNS3. The rest you must add.
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GNS3 supports a number of different types of virtual devices for use within your simulated network
topologies. Most devices you can install by simply double-clicking on them (or by starting to drag one to
a topology) to start an install wizard as shown on the next page.

In this case, the wizard is starting to add the Alpine Linux device.
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A critical factors in most cases, is the need to run everything in the GNS3 VM when asked. Always
choose to install and run devices within the GNS3 VM as shown below.
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Once the install is finished, the device should no longer be grey in your list of devices and can now be

dragged and dropped into a topology for use. The first time some devices are added to a topology, they
will perform a one-time download via a Docker pull.



Other times when you attempt to add a device, it will present a screen such as the following one saying
there are missing files.
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Simply select the missing file(s) from the list, and the Download button near the bottom left of the
dialog box will become available. Clicking this Download button will launch a browser and take you to
download the file (if there are more than one needed file, rinse and repeat). Once you have

downloaded any needed files, click the Refresh button and the screen should switch to saying Ready to
Install as shown.
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To finish the install, select the Ready to Install line and click Next to proceed until the Finish button,
choosing defaults as needed. This device will then be available from the list for use.



There is another way to install devices, which involves using the Edit, Preferences menu screen. GNS3
support numerous device types as can be seen from the side menu of the Preferences screen. The
following example shows adding a new Docker Container. The image name could be any valid Docker

pull path.
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Once you have GNS3 up and running, and have added some devices to work with, you will probably then
either want to import an existing portable project someone has given you or start your own. Importing
a GNS3 portable projects is easy, simply use the Import portable project choose from the File menu.

& My First Project - GNS3

ﬂ Edit View Control Annotate Tools Help
B New blank project Ctrl+N [~
& Open project Ctrl+0 b

By Save project as...
> Edit project
i Delete project
#] Export portable project
& |mport appliance
1. My First Project.gns3
2. ThrtVul-BaseTopa-MNew-Baseline.gns3
3. PenTest+ TTT-Class-Starter.gns3
4, MetDef-BaseTopo-Mew-Baseline-RIP-Open-Class-Starter.gns3

5. lessenBhandson2forlee-chris-s-02.gns3

4= Quit Ctrl+Q
-
m)
—

Navigate to the portable project file, it should have a .gns3project file extension to its name.



Otherwise, start creating your own topology by dragging in devices and wiring them up with the
provided tools. Start by dragging in an Ethernet Switch, note the need to run it in the GNS3 VM as
shown.

& Server 7 »

Fease choose a server
G VM (GIS3 Vi) =

o1 conca
Then add a few more devices. In the example below we have added two Ubuntu devices and are
beginning to connect them together with cabling using the last button on the left side bar which should

look like a network cable (or maybe to some a phone cable © ).

& My First Project - GNS3
Eile Edit Yiew Control MNode Annctate Tools Help

B OF> > HC Fmiilo - aanE

Ubuntu-1

wmemid-l

Ubuntu-2

4

01" S

When you click on a device in this cabling mode, a selection pop up will let you choose which port you
are connecting the cable to, if there is a choice. Once you have finished wiring up your topology, click
the cabling button again to turn off cabling mode.

& My First Project - GNS3
File Edit View Control Node Annctate Tocls Help

B OF> > "BC PmIIo-- - Qaam

Ubuntu-1

AT

‘Wrneiswitdrl

UderO]h @

You will notice that the switch is already ‘on’ (thus the green lights) but the Ubuntu clients need to be
started. To bring up the context menu on any device, simply right-click on it.



& My First Project - GNS3
File Edit View Control Node Annctate Tools Help

B OB> > BC Fmililio s aamE

Ubuntu-1
&, Configure

‘¥ Change hostname
o Change symbol

Duplicate

W Show in file manager Ubuntu-2
B Conszole b
B Custormn console
@ Auxiliary conscle
4 EBring to front
# Import config

Uet Ol

= | Export config r
¢ » Edit config
L

Running ENS3 version 2.1.2 on Windows (64-5it) with Python 3.6.3 || | Sucpend

Copyright (c) 2006-2018 GNS3 Technologies,

Use Help -> GNS3 Doctor to detect common issues, M Stop

=> f : t % Reload
B Command line
E_’, Raise one layer
£ Lower one layer
& Delete

As you can see, you can Start, Stop, Configure, Delete, Duplicate, and a number of other choices for each
device. The Start, Stop and other buttons along the top button bar affect the entire project (i.e., turning
EVERYTHING on or off together), but you can affect individual devices using this right-click menu.

Once a device is running, you can right-click again and select Console to bring up a Console. This will
either be a Putty session (telnet/console type connections) or a VNC window (remote desktop type
connections).

File Edit View Control Node Annotate Tools Help

e OF> b HC FElllicos-aaam

§ Ubuntu-1 = a X 3
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Using these consoles, you can configure and run the devices as you would a real system since they are
virtual emulations of the real thing. There are way too many devices to attempt to cover in this guide.
But the GNS3 website and Marketplace has tons of useful information and links.

We will close this guide with some common trouble shooting tips.

1. If the GNS3 VM doesn’t run correctly and get the right IP address range, double-click the VM’s
settings. The GNS3 VM actually has two network interfaces. The first should be on the host-
only adapter and the second should be on NAT with both getting their IP addresses via DHCP. If
this is not happening, double-check the virtual network settings of either VirtualBox or VMWare.

2. If the GNS3 VM runs fine and gets the right IP address, but the GNS3 GUI will not connect, it is
usually due to host binding errors. Either the wrong IP was entered or this IP address has
changed due to maybe a reboot and assignment of new IP address. You will see errors like:

€% Local server =
Could not bind with 192.168.101.112: [WinError 10049] The requested address is
not walid in its context (please check your host binding setting in the preferences)
OK
€& Local server >
8 Could not start the local server process: C\Program Files\GMNS3\gns3server.EXE
Ok

To fix this, cancel the new project dialog and go to Edit, Preferences, Server and change the IP
of the host binding drop-down as shown to match your real IP address.

Docker Containers

152.168.119.1
=1
127.0.0.1
2001:0:4137:0876:851:3240:cdabit6te
YT 1e80:851:3248: cab:6f cSetunnel 32768

0.0.0.0

€ Preferences ? x
General |Server preferences
GNS3 VM
Packet capture Main server | Remote servers
~ Built-in
Ethernet hubs 1 Enable local server
Ethernet switches General settings
v vodes -
VPCS nodes C:\Program Files\GNS3\gns3server EXE Browse...
~ Dynamips Ubridge path:
e 1 égso;ol:u;e&s (C:\Program Fes\GNis3\bridoe. EXE Browse
IOU Devices fedl:afed:ed2:5b7c2ba4%ethernet_32769
~ QEMU 192.168.101.108
Qemu VMs fe80::1887:2285 feTe:8a39% ethernet_32772
[~ VirtualBox 192.168.56.1
- V‘lfll\:t:ra elBox VMs 1e80::1037-e45:16C64T6%ethemet_32770
VMware VMs 192.168.157.1
~ Docker 1e80:931:667d:bOf5: be2 ¥ethernet_32771
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Restore defauits

Apply




